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AutoCAD 2005 takes productivity to the next level, not just in terms of speed and power, but also in terms of more 
effective ways of creating and managing the project information that is encapsulated in your final documentation. 
The benefits—dramatic time savings and better coordinated documentation. 
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Introducing Sheet Sets 

Sheet Set Manager 

AutoCAD command: sheetset 

The Sheet Set Manager organizes, displays, and manages sheet sets, a named collection 
of drawing sheets. Each sheet in a sheet set is a layout in a drawing (DWG) file.  

The top of the Sheet Set Manager window contains a list box, called the Sheet List 
control, and several buttons. The buttons vary, depending on the selected tab.  

The Sheet Set Manager window displays the following tabs:  

• Sheet List tab 

• View List tab  

• Resource Drawings tab 

Sheet List Control  

The Sheet List control displays the name of the current sheet set, or, if no sheet sets are 
open, the Open option. The Sheet List control provides the following options for all tabs:  

Names of Open Sheet Sets  

Lists all open sheet sets, if any. A check is displayed next to the current sheet set. The 
current sheet set is the open sheet set that is displayed in the Sheet Set Manager window.  

Recent : Displays a list of recently opened sheet sets.  

New Sheet Set : Starts the Create Sheet Set wizard. Open : Displays the Open Sheet Set 
standard file selection dialog box. 
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View and Modify a Sheet Set 

Once you create a sheet set, you view and make changes to the sheet set in the Sheet Set 
Manager.  

Note: Before you begin the tutorial, if you have not already done so, copy the Tutorials 
folder from the Destination Desktop CD-Rom to My Documents. 

Open a Sheet Set 

You create a new sheet set using the Create Sheet Set wizard. You use the Sheet Set Manager 
to organize, view, and manage a sheet set. In this exercise, you work with a sheet set that has 
already been created.  

1. If you have not already done so, copy the Tutorials folder from CD-Rom to My 
Documents.  

2.  In AutoCAD, if the Sheet Set Manager is not already open, on the Standard 
toolbar, click Sheet Set Manager.  

The Sheet Set Manager contains three tabs: Sheet List, View List, and Resource 
Drawings. In this exercise, you use the Sheet List tab.  

3. In the Sheet Set Manager, click the arrow next to the Open box, and then click 
Open.  

4. In the Open Sheet Set dialog box, browse to the My 
Documents\Tutorials\ViewSheetSet folder, select ABC Project.dst, and then click Open.  

The ABC Project sheet set is displayed in the Sheet Set Manager. 

View a Sheet 

The ABC Project sheet set contains three numbered sheets: A1 - Plans, A2 - Elevations, and A3 - 
Foundation Plan. Each sheet is the equivalent of a printed drawing sheet. Each sheet refers to 
the layout tab of a separate drawing file. You use the Sheet Set Manager to open a drawing 
directly; you do not need to browse for the drawing file.  

1. In the Sheet Set Manager, on the Sheet List tab, double-click the Plans sheet.  

The Plans sheet opens, with the Plans layout tab currently active.  

The Plans sheet was created using a default template. The template contains information 
shared by all sheets, such as a title block, sheet size, page layout, and so on. You can 
view the name of the default template in the sheet set properties.  

2. In the Sheet Set Manager, under Sheets, right-click ABC Project, and on the 
shortcut menu, click Properties.  

3. In the Sheet Set Properties dialog box, under Sheet Creation, click Sheet 
Creation Template.  

The file listed under Sheet Creation Template (ABC.dwt) is the default template used for 
creating all new sheets in this sheet set.  

Do not close the Sheet Set Properties dialog box.  
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View the Sheet Storage Location 

All of the sheets in a sheet set are stored in one or more folders.  

1. In the Sheet Set Properties dialog box, under Sheet Creation, click Sheet 
Storage Location.  

The folder listed under Sheet Storage Location is where all of the sheets in this sheet set 
are stored. By default, any new sheets you create are also stored in this location.  

2. Click OK to close the Sheet Set Properties dialog box.  

3. Open Windows Explorer.  

4. In Windows Explorer, browse to the folder listed in the Sheet Set Manager under 
Sheet Storage Location: My Documents\Tutorials\ViewSheetSet.  

Notice that for each sheet in your sheet set (Plans, Elevations, and Foundation Plan), there 
is a corresponding drawing file.  

Also, notice that each sheet in your sheet set is numbered, but the corresponding drawing 
files are not.  

Because the sheet number is a sheet property (instead of part of the drawing file name), 
you can use the Sheet Set Manager to reorder and renumber your sheets without having 
to rename your drawing files.  

 

Create a New Subset 

The ABC Project sheet set currently contains one subset called Architectural. You can create 
additional subsets and organize your sheets accordingly.  

1. In AutoCAD, in the Sheet Set Manager, on the Sheet List tab, right-click ABC 
Project, and on the shortcut menu, click New Subset.  

2. In the Subset Properties dialog box, under Subset Name, enter Structural.  

For each subset, you can set the sheet storage location and the default template. By 
default, these two settings are the same as for the sheet set. Leave these settings as they 
are.  

3. Click OK to close the Subset Properties dialog box.  

A new subset, Structural, is displayed at the bottom of the list.  

4. In the Sheet Set Manager, click the Foundation Plan sheet to select it, and drag it 
under the Structural subset (Structural subset becomes highlighted).  

The Foundation Plan sheet is now part of the Structural subset.  

5. To change the sheet number, right-click the Foundation Plan sheet, and on the 
shortcut menu, click Rename and Renumber.  

6. In the Rename and Renumber Sheet dialog box, under Number, replace A3 with 
S1.  

7. Click OK to close the Rename and Renumber Sheet dialog box.  
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Create a New Sheet 

When you create a new sheet, a layout is created in a new drawing using the template that is 
specified in the Sheet Set Properties dialog box. The drawing is stored in the folder that is 
specified in the Sheet Set Properties dialog box.  

1. In the Sheet Set Manager, right-click the Architectural subset, and on the 
shortcut menu, click New Sheet.  

2. In the New Sheet dialog box, under Number, enter A3.  

3. Under Sheet Title, enter Sections.  

4. Under File Name, delete the text A3.  

Because you may want to reorder or renumber your sheets, you don't want to include 
sheet numbers in your drawing file names. If the sheet number is a sheet property (instead 
of part of the drawing file name), you can use the Sheet Set Manager to reorder and 
renumber your sheets without having to rename your drawing files.  

5. Click OK to close the New Sheet dialog box.  

6. In Windows Explorer, browse to the default sheet storage location: My 
Documents\Tutorials\ViewSheetSet  

Notice that a new drawing (Sections.dwg) was created in the folder. When you create a 
new sheet, a new drawing is created using the default template.  

7. In the Sheet Set Manager, double-click the Sections sheet.  

The Sections drawing opens, with the Sections layout tab currently active. This is the 
drawing (with layout) that was created when you used the Sheet Set Manager to create a 
new sheet.  

8. Close all drawings without saving changes.  

9. To close the ABC Project sheet set, in the Sheet Set Manager, on the Sheet List 
tab, right-click ABC Project, and on the shortcut menu, click Close Sheet Set.  

Wrap Up 

You create a sheet set in the Create Sheet Set wizard. You use the Sheet Set Manager to view 
and manage sheet sets. When you create a new sheet, a new drawing is created using a default 
template. You can organize your sheets into subsets or logical categories. You can also reorder 
and renumber your sheets without having to rename your drawing files.  
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Place a View of a Drawing on a Sheet 

Once you've created your sheets, you use the Sheet Set Manager to place a view of a drawing on a sheet. To 
place a view of a drawing on a sheet, you no longer need to manually attach an external reference (xref), 
create a viewport, zoom to the correct view, and scale within the viewport. The Sheet Set Manager 
automates these steps.  

Note: Before you begin the tutorial, if you have not already done so, copy the Tutorials 
folder from the Destination Desktop CD-Rom to My Documents. 

Open a Sheet 

You use the Sheet Set Manager to open a sheet in a sheet set.  

1. If you have not already done so, copy the Tutorials folder from CD-ROM to My 
Documents.  

2.  In AutoCAD, if the Sheet Set Manager is not already open, on the Standard 
toolbar, click Sheet Set Manager.  

3. In the Sheet Set Manager, click the arrow next to the Open box, and then click Open.  

4. In the Open Sheet Set dialog box, browse to the My Documents\Tutorials\PlaceView 
folder, select XYZ Project.dst, and then click Open.  

The XYZ Project sheet set is displayed in the Sheet Set Manager.  

On the Sheet List tab, the XYZ Project sheet set contains two numbered sheets: A1 - 
Floor Plans and A2 - Building Elevations. Each sheet refers to the layout tab of a 
separate drawing file.  

5. In the Sheet Set Manager, on the Sheet List tab, double-click the Floor Plans sheet.  

The Floor Plans sheet opens.  

The Floor Plans sheet is currently empty except for a title block. You want to add a plan 
from the XYZ_Walls.dwg file to the Floor Plans sheet.  

Add Resource Drawings 

Before you can add a plan to the Floor Plans sheet, the model drawing file (XYZ_Walls.dwg) containing the 
plan must be accessible from the Resource Drawings tab of the Sheet Set Manager. You need to add any 
drawing files that you want to use.  

1. In the Sheet Set Manager, click the Resource Drawings tab.  

The Resource Drawings tab currently contains no model drawings.  

2. To add model drawings, under Location, double-click Add New Location.  
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3. In the Browse for Folder dialog box, browse to the My 
Documents\Tutorials\PlaceView\Models folder, and then click Open.  

All the drawings in the Models folder (XYZ_Walls.dwg and XYZ_Elevations.dwg) are 
now displayed in the Resource Drawings tab.  

Place a View on a Sheet 

You place views of model drawings onto sheets from the Resource Drawings tab.  

1. On the Resource Drawings tab, under Locations, click XYZ_Walls.dwg to select it.  

2.  Under Details, click Preview to view a thumbnail image of XYZ_Walls.dwg.  

3. With XYZ_Walls.dwg still selected, right-click, and on the shortcut menu click Place on 
Sheet.  

A view of XYZ_Walls.dwg, zoomed to extents, is displayed on your sheet at a default 
scale.  

4. To change the scale, right-click anywhere on the screen, and then select 1/8" = 1'-0".  

5. Click anywhere on your sheet to place the view.  

The view is placed on your sheet at the scale you selected.  

Notice that a label block is automatically inserted with the view. The default label block 
is specified in the sheet set properties.  

When you place a view on a sheet, AutoCAD attaches the drawing containing the view 
as an xref. AutoCAD also creates a viewport zoomed to the scale you selected. To place 
a view on a sheet, you no longer need to manually attach an xref, create a viewport, or 
zoom to the correct view and scale within the viewport. With the Sheet Set Manager, 
these steps are automated.  

Rename a Sheet View 

Once a model space view is placed on a sheet, the view is listed as a paper space view on the View List tab. 
You rename a paper space view on the View List tab.  

1. In Floor Plans.dwg, zoom in on the label block so that you can read the text.  

The label block displays the view title and the view scale. You can change the view title 
from the View List tab.  

2. In the Sheet Set Manager, click the View List tab.  

Under Views, XYZ_Walls is listed as a paper space view.  

3. Right-click XYZ_Walls, and on the shortcut menu, click Rename and Renumber.  

4. In the Rename and Renumber View dialog box, under View Title, replace XYZ_Walls 
with Floor Plan, and then click OK.  

5. On the View menu, click Regen.  



Place a View of a Drawing on a Sheet 

Page 9 of 32 

The label block is updated with the new view title.  

Create a Named View 

To place a specific view (instead of a view zoomed to extents) of your model drawing onto your sheet, first 
you create a named view in your model drawing.  

1. In the Sheet Set Manager, on the Resource Drawings tab, right-click 
XYZ_Elevations.dwg, and on the shortcut menu, click Open.  

XYZ_Elevations.dwg opens in a separate window. The drawing contains four elevations.  

2. In XYZ_Elevations.dwg, zoom in on the first elevation, in the area enclosed by the dashed 
lines.  

3. On the View menu, click Named Views.  

4. In the View dialog box, on the Named Views tab, click New.  

5. In the New View dialog box, under View Name, enter Front Elevation.  

6. Under View Category, select Elevation.  

7. Click OK to close the New View dialog box.  

8. Click OK to close the View dialog box.  

9. Save and close XYZ_Elevations.dwg.  

Place a Named View on a Sheet 

Named views in your model drawing are displayed in the Sheet Set Manager on the Resource Drawings 
tab. You use the Sheet Set Manager to place model space views on your sheets.  

1. In the Sheet Set Manager, on the Sheet List tab, double-click the Building Elevations 
sheet to open the sheet.  

2. In the Sheet Set Manager, click the Resource Drawings tab, and then click Refresh.  

3. Click the plus sign next to XYZ_Elevations.dwg to expand the list of named model space 
views.  

The model space view you created, Front Elevation, is listed under 
XYZ_Elevations.dwg.  

4. Right-click Front Elevation to select it, and on the shortcut menu, click Place on Sheet.  

The view is displayed on your sheet at a default scale.  

Notice that on the command line you are prompted to specify an insertion point or scale.  

5. To change the scale, right-click anywhere on the screen, and then select 1/8" = 1'-0".  

6. Click anywhere on your sheet to place the view.  

The view is placed on your sheet at the scale you selected.  

Notice that a label block is inserted with the view.  
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Organize Sheet Views into View Categories 

You organize sheet views into view categories on the View List tab. In a large sheet set with many sheet 
views, view categories provide a way of organizing your views logically.  

1. In the Sheet Set Manager, click the View List tab.  

Under Views, the Floor Plan sheet view and the Elevations view category are listed.  

2. Double-click the Elevations view category to expand its contents.  

The Front Elevation sheet view is listed under the Elevations view category. When you 
created the model space view in Building Elevations.dwg, you placed the model space 
view in the Elevations view category. You can also create a view category from the 
View List tab.  

3. On the Views tab, right-click the XYZ Project sheet set, and on the shortcut menu, click 
New View Category.  

4. In the View Category dialog box, under Category Name, enter Plans, and then click OK.  

The Plans view category is listed on the View List tab.  

5. Click the Floor Plan sheet view to select it, and drag it under the Plans view category 
(Plans view category becomes highlighted).  

The Floor Plan sheet view is now part of the Plans view category.  

6. Close all drawings without saving changes.  

7. To close the XYZ Project sheet set, in the Sheet Set Manager, on the Sheet List tab, right-
click XYZ Project, and on the shortcut menu, click Close Sheet Set.  

Wrap Up 

You use the Sheet Set Manager to add views of drawings to your sheets; for example, you can add a plan 
view or an elevation. When you place a view of a drawing on a sheet, a label block is included with the 
view.  

You can also use the Sheet Set Manager to organize sheet views into view categories.  
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Publish an Electronic Sheet Set 

You use the Sheet Set Manager to publish an electronic version of a sheet set that you can email 
to a client who does not use AutoCAD. You publish the sheet set as a Design Web Format (DWF) 
file. DWF files can be viewed and plotted with the Autodesk DWF Viewer, a free viewer available 
from www.autodesk.com. For security, you can also add a password to your DWF file.  

Note: Before you begin the tutorial, if you have not already done so, copy the Tutorials folder 
from the Destination Desktop CD-Rom to My Documents. 

Open a Sheet Set and View a Sheet 

You open and view a sheet set in the Sheet Set Manager.  

1. If you have not already done so, copy the Tutorials folder from CD-Rom to My 
Documents.  

2.  In AutoCAD, if the Sheet Set Manager is not already open, on the Standard 
toolbar, click Sheet Set Manager.  

3. In the Sheet Set Manager, click the arrow next to the Open box, and then click 
Open.  

4. In the Open Sheet Set dialog box, browse to the My 
Documents\Tutorials\PublishSheetSet folder, select School Project.dst, and then click 
Open.  

The School Project sheet set is displayed in the Sheet Set Manager.  

5. In the Sheet Set Manager, on the Sheet List tab, double-click the sheet Plan 1.  

The Existing Conditions Plan drawing opens, with the Plan 1 layout tab currently active. 
This drawing contains the sheets you want to include in your DWF file.  
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Create and Publish a DWF File 

When you publish a DWF file using the Publish to DWF button, the DWF file is published using 
the default settings (output directory, single- or multi-page DWF, and layer information). You can 
change any of the default settings.  

1. In the Sheet Set Manager, on the Sheet List tab, click the Existing Conditions 
subset to select it.  

2.  In the Sheet Set Manager, click Publish to DWF.  

3. In the Select DWF File dialog box, in the File Name text box, enter Existing 
Conditions, and then click Select.  

Before the DWF is published, a message is displayed notifying you that the publishing job 
is processing in the background. While the job is publishing, you can continue to work.  

4. Click OK to close the message.  

The DWF file is published. This may take several seconds. When publishing is complete, a 
balloon message is displayed in the status bar tray.  

5. In the Plot and Publish Job Complete balloon message, click the link to view plot 
and publish details.  

In the Plot and Publish Details dialog box, information (file name, page setup, paper size, 
and so on) about each published sheet is displayed.  

6. Click Close to close the Plot and Publish Details dialog box.  

7.  On the status bar tray, right-click the Plot and Publish icon, and on the 
shortcut menu, click View DWF File.  

The Existing Conditions DWF file opens in Autodesk DWF Viewer. The file contains all the 
sheets in the Existing Conditions subset.  

8. Close the Autodesk DWF Viewer.  

Include Layer Information 

When you publish a DWF file with a single click, the DWF file is published using the default 
settings (output directory, single- or multi-page DWF, and layer information).  

1. In the Sheet Set Manager, on the Sheet List tab, click the Site Grading subset to 
select it.  

2.  In the Sheet Set Manager, click Publish, and then click Sheet Set Publish 
Options.  

3. In the Sheet Set Publish Options dialog box, make sure Multi-sheet DWF and 
Prompt for Name are selected.  

4. Under DWF Data, click Layer Information, and select Include.  

When layer information is included in a DWF file, you can use the Autodesk DWF Viewer 
to control layer visibility in the file.  

Do not close the Sheet Set Publish Options dialog box.  
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Add a Password 

When you need to control who can open and view a confidential drawing set, you can publish a 
DWF file that is protected with a password. A password-protected file can be opened only by 
someone who knows the correct password.  

1. In the Sheet Set Publish Options dialog box, under DWF Security, click 
Password Protect Published DWF. Make sure Specify Password is selected, and then 
enter my password.  

2. Click OK to close the Sheet Set Publish Options dialog box.  

3. In the Confirm DWF Password dialog box, enter my password again, and then 
click OK.  

 

Publish and View a Password-Protected DWF File 

DWF files can be opened and viewed with the Autodesk DWF Viewer. Because you protected the 
DWF file with a password, you need to enter the password before you can open the file.  

1.  In the Sheet Set Manager, click Publish to DWF.  

2. In the Select DWF File dialog box, enter Site Grading, and then click Select.  

Before the DWF is published, a message is displayed notifying you that the publishing job 
is processing in the background. While the job is publishing, you can continue to work.  

3. Click OK to close the message.  

The DWF is published. This may take several seconds. When publishing is complete, a 
balloon message is displayed in the status bar tray.  

4. Close the Plot and Publish Job Complete balloon message.  

5.  On the right side of the status bar tray, right-click the Plot and Publish icon, 
and on the shortcut menu, click View DWF File.  

6. In the Enter Password dialog box, enter my password.  

Because you entered the correct password, you are able to open the DWF file. The Site 
Grading DWF file opens in Autodesk DWF Viewer. The DWF contains all the sheets in the 
Site Grading subset.  

7. Close the Autodesk DWF Viewer.  

8. To close the School Project sheet set, in the Sheet Set Manager, on the Sheet 
List tab, right-click School Project, and on the shortcut menu, click Close Sheet Set.  

Wrap Up  

You use the Sheet Set Manager to publish a Design Web Format (DWF) file. A DWF file is an 
electronic version of a drawing set. A DWF file can be viewed and plotted with the Autodesk DWF 
Viewer, a free viewer available from www.autodesk.com. For security, you can protect a DWF file 
with a password.  
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When you need to send a sheet set to consultants or clients, you can use the Sheet Set Manager 
to create a transmittal package containing the sheets you want to send. Any reference files (sheet 
set data files, xrefs, plot configuration files, font files, and so on) are automatically included.  

Note: Before you begin the tutorial, if you have not already done so, copy the Tutorials folder 
from the Destination Desktop CD-Rom to My Documents.  

Open a Sheet Set 

You open a sheet set in the Sheet Set Manager.  

1.  In AutoCAD, if the Sheet Set Manager is not already open, on the Standard 
toolbar, click Sheet Set Manager.  

2. In the Sheet Set Manager, click the arrow next to the Open box, and then click 
Open.  

3. In the Open Sheet Set dialog box, browse to the My 
Documents\Tutorials\createTransmittal folder, select Washing Unit.dst, and then click 
Open.  

The Washing Unit sheet set is displayed in the Sheet Set Manager.  

4. In the Sheet Set Manager, on the Sheet List tab, double-click the Drive Roller 
sheet.  

The Drive Roller sheet opens.  

Before you can create a transmittal package, you must first save all open drawings.  

5. Save Drive Roller.dwg.  
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Save a Selection of Sheets 

You want to create a transmittal package containing some, but not all, of the sheets in the sheet 
set. You can select the sheets you want to include and save the selection of sheets. By saving 
sheets as a selection, you can quickly add these sheets to a transmittal package.  

1. In the Sheet Set Manager, on the Sheet List tab, hold down the CTRL key and 
select the following sheets: Cover Sheet, Drive Roller, and Brush Roller.  

2.  Click Sheet Selections, and then click Create.  

3. In the New Sheet Selection dialog box, enter the sheet selection name 
Transmittal, and then click OK.  

4. In the Sheet Set Manager, click the Washing Unit sheet set.  

Notice that the sheets are no longer selected. However, because you saved the previous 
selection of sheets, you can quickly select them whenever you need to.  

5.  Click Sheet Selections, and then click Transmittal.  

Notice that the sheets in the Transmittal sheet selection are now selected.  

 

 

Create a Report of the Transmittal 

You can generate a report about the transmittal package. The report contains information about 
all files included in the transmittal package.  

1. In the Sheet Set Manager, make sure that the sheets in the Transmittal sheet 
selection are still selected.  

Next, place your cursor over one of the selected sheets, right-click, and on the shortcut 
menu, click eTransmit.  

In the Create Transmittal dialog box, on the Sheets tab, all the sheets you selected are 
listed.  

2. In the Create Transmittal dialog box, click the Files Tree tab.  

On the Files Tree tab, all the xref files, sheet set data files, and template files are listed.  

3. Under Enter Notes to Include with This Transmittal Package, enter My 
transmittal.  

4. Click View Report.  

The transmittal report contains information about files included in the transmittal package. 
The report also contains the note you entered.  

5. When you are finished viewing the report, in the View Transmittal Report dialog 
box, click Close.  

Do not close the Create Transmittal dialog box.  
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View the Transmittal Setup 

The transmittal setup is a set of options used to create a transmittal package. Options include 
transmittal package format (ZIP, self-extracting EXE file, or folder), transmittal package file name, 
email options, and so on. You can save multiple transmittal setups.  

1. In the Create Transmittal dialog box, click Transmittal Setups.  

2. In the Transmittal Setups dialog box, click Modify.  

3. In the Modify Transmittal Setup dialog box, under Transmittal Package Type, 
click the arrow to expand the list.  

You can create a transmittal package as a ZIP file, a self-executing EXE file, or a folder. 
Leave this setting at ZIP.  

4. Under Transmittal Filename, make sure that Prompt for Filename is selected.  

5. Under Transmittal Options, make sure that Include Fonts and Include Sheet Set 
Data and Files are both selected.  

6. Click OK to close the Modify Transmittal Setup dialog box.  

7. Click Close to close the Transmittal Setups dialog box.  

Do not close the Create Transmittal dialog box.  

 

Add a File to the Transmittal Package 

Before creating a transmittal package, you can include additional files. Here, you add a Microsoft 
Word document.  

1. In the Create Transmittal dialog box, on the Files Tree tab, click Add File.  

2. In the Add File to Transmittal dialog box browse to the My 
Documents\Tutorials\CreateTransmittal folder, select Additional Notes.doc, and click Open.  

On the Files Tree tab, under User Added Files, notice that Additional Notes.doc is now 
listed.  

You can include any type of file (Word documents, Excel spreadsheets, PDFs, and so on) 
in the transmittal package.  

Do not close the Create Transmittal dialog box.  

Create the Transmittal Package 

Next, you create the transmittal package and save it as a ZIP file.  

1. In the Create Transmittal dialog box, click OK.  

2. In the Specify Zip File dialog box, accept the default file name, and click Save.  

The transmittal package is created (this may take a few seconds). The transmittal is a ZIP 
file. You can send this file to consultants and clients via email.  

3. To close the Washing Unit sheet set, in the Sheet Set Manager, on the Sheet List 
tab, right-click Washing Unit, and on the shortcut menu, click Close Sheet Set.  
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Wrap Up 

When you need to send a sheet set to consultants or clients, you use the Sheet Set Manager to 
create a transmittal package containing the sheets you want to send. Any reference files (sheet 
set data files, xrefs, plot configuration files, font files, and so on) are automatically included.  

You can create a report of the transmittal package. You can also include any type of file (Word 
documents, Excel spreadsheets, PDFs, and so on) in the transmittal package.  
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Create Fields 

You can insert a field within any text object to display data in the drawing or sheet set that you 
expect to change. When the field is updated, the latest data is automatically displayed.  

Fields can include information such as area, layer, date, file name, page setup size, and so on.  

Note: Before you begin the tutorial, if you have not already done so, copy the Tutorials folder 
from the Destination Desktop CD-Rom to My Documents.  

Create a Field to Display a Polygon's Area 

You create a field within multiline text to display the area of a polygon.  

1. If you have not already done so, copy the Tutorials folder from the CD-ROM to My 
Documents.  

2. In AutoCAD, open My Documents/Tutorials/polygon.dwg.  
The drawing contains a polygon. You want to create a field inside the polygon that shows 
its area. You create a field within multiline text (mtext).  

3.  On the Draw toolbar, click Multiline Text.  

4. Click two points inside the polygon to select a bounding box for the mtext.  

The Multiline Text Editor and the Formatting Text toolbar are displayed.  

5. In the Multiline Text Editor, enter AREA =. Then, right-click, and on the shortcut menu, 
click Insert Field.  

6. In the Field dialog box, under Field Category, make sure that All is selected.  
When All is selected, the types of fields you can create are listed under Field Names.  

7. Under Field Names, select Object.  

8.  Under Object Type, click the Select Object button.  
The Field dialog box temporarily closes so you can select an object.  

9. Click the polygon to select it.  
The Field dialog box is displayed. Next, you select the property type and format (units) for 
the field.  

10. Under Property, select Area.  

11. Under Format, select Architectural, and then click OK to close the dialog box.  
In the Multiline Text Editor, the area of the polygon is displayed in square feet. Notice that 
the field text is displayed in the polygon with a light gray background. The background 
color is a visual cue that this part of the text is a field. The background color does not 
plot.  

12. Click anywhere outside the Multiline Text Editor to close the editor.  
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Update the Field Information of a Polygon 

When you change the size of the polygon, you can easily update the field information.  

1. Click the polygon to select it.  
The grips on the polygon are highlighted.  

2. Click any grip to select it, drag the grip to change the shape of the polygon, and then click 
again to release the grip.  

3. Press ESC to clear the selection.  
Next, you update the field information.  

4. In the polygon, double-click the mtext to open the Multiline Text Editor.  

5. In the Multiline Text Editor, click the field text to select it. Right-click, and on the shortcut 
menu, click Update Field.  
The field information changes to reflect the area of the modified polygon.  

6. Click anywhere outside the Multiline Text Editor to close the editor.  

Create a Field to Display the Time 

You can also create a field from the Insert menu. This time, you create a field to display the time.  

1. On the Insert menu, click Field.  

2. In the Field dialog box, under Field Category, make sure that All is selected.  
When All is selected, the types of fields you can create are listed under Field Names.  

1. In the Field Names list, select Date.  

2. Under Examples, select the example that displays the time with hours, minutes, and 
seconds.  
Date Format is now shown as h:mm:ss tt.  

3. In the Fields dialog box, click OK.  
A field showing the current time is displayed in the drawing.  

4. Click anywhere in the drawing to place the field.  

Update Field Information for Time 

You can update the field information from the Tools menu.  

1. In the drawing, click the Time field to select it.  

2. With the field still selected, on the Tools menu, click Update Fields.  
The field information changes to reflect the current time.  

Wrap Up 

Fields are useful for displaying changeable data within text objects. When you change the object, 
you can update the field to display the latest data. 



Create a Table 
 

   Page 20 of 32 
 

Create a Table 

Instead of creating tables manually using individual lines and text objects, you can automate the 
process by creating a table object. Once you create a table, you enter text or add blocks to the 
table cells.  

Note: Before you begin the tutorial, if you have not already done so, copy the Tutorials folder 
from the Destination Desktop CD-Rom to My Documents. 

You create a table from the Draw toolbar. Then, you enter a title and column headers.  

1. If you have not already done so, copy the Tutorials folder from CD-Rom to My 
Documents.  

2. In AutoCAD, open My Documents/Tutorials/8th Floor Power.dwg.  
You want to create a legend for the electrical symbols used in the drawing. Instead of 
manually arranging individual lines, blocks, and text to create the legend, you create a 
table object.  

3.  On the Draw toolbar, click Table.  

4. In the Insert Table dialog box, under Insertion Behavior, make sure that Specify an 
Insertion Point is selected.  

5. Under Column & Row Settings, set the number of columns to two, and the number of 
data rows to one.  

6. Click OK to close the Insert Table dialog box.  

7. Click in the drawing where you want to place the table.  
The Text Formatting toolbar is displayed, and the title row of the table is selected.  

8. In the title row of the table, enter LEGEND, and then press TAB.  
The first column header row is now selected. Pressing TAB selects the next table cell.  

9. In the first column header row, enter SYMBOL, and then press TAB.  
The second column header row is now selected.  

10. In the second column header, enter DESCRIPTION, and then click outside the able to 
close the Text Formatting toolbar.  
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Insert a Block in a Table Cell 

Next, you insert blocks in table cells.  

1. In the table, click inside the first cell under SYMBOL to select it.  
Grips are displayed on the cell you selected.  

2. Right-click, and on the shortcut menu, click Insert Block.  

3. In the Insert a Block in a Table Cell dialog box, under Name, select _2PLEX.  

4. Under Properties, set the Cell Alignment to Middle Center, and then click OK.  
The block _2PLEX is inserted in the table cell. Next, you enter a description for the block.  

5. In the table, double-click the cell next to the block _2PLEX to open the Text Formatting 
toolbar.  

6. In the cell, enter 2PLEX OUTLET.  

7. Click anywhere outside the table to close the Text Formatting toolbar.  

 

Add a Row to a Table 

You want to add another electrical symbol to your table, so you need to add an additional row.  

1. In the table, click inside the cell containing the block _2PLEX to select it, right-click, and 
on the shortcut menu, click Insert Rows > Below.  
A new row is added to the table below the current row.  

2. Click inside the empty cell under the block _2PLEX to select it, right-click, and on the 
shortcut menu, click Insert Block.  

3. In the Insert a Block in a Table Cell dialog box, under Name, select _4PLEX.  

4. Under Properties, set the cell alignment to Middle Center, and then click OK. 
The block _4PLEX is inserted in the table cell. Next, you enter a description for the block.  

5. In the table, double-click the cell next to the block _4PLEX to open the Text Formatting 
toolbar.  

6. In the cell, enter 4PLEX OUTLET.  

Click anywhere outside the table to close the Text Formatting toolbar.  

Change Properties in a Table 
You can change the format of the text in the table.  

1. In the drawing, zoom in on the table object so you can see the text changes more easily.  

2. In the table, click the first row (LEGEND) to select it. Then, hold down the SHIFT key and 
click the second row (SYMBOL and DESCRIPTION).  

3. The first two rows are now selected. To select multiple rows, you hold down the SHIFT 
key.  

4. Next, you use the Properties palette to change the Text Style in these two rows.  

5. With the two rows still selected, right-click, and on the shortcut menu, click Properties.  

6. The Properties palette is displayed.  
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7. In the Properties palette, under Content, click Text Style to select it, and change the text 
style from Standard to Title.  

8. The text in the title and header rows is now displayed in a bold font, which is the Title 
style.  

9. Close the Properties palette.  

10. Press ESC to clear the selection in the table.  

 

Use Grips to Modify a Column 

You use grips to resize a table. By pressing CTRL while moving the grips, you can change a 
column width without changing the overall width of the table.  

1. Click any edge of a table to select the entire table.  

Notice that grips are located on all corners of the table, as well as on the top corners of 
each column.  

2. Press CTRL to keep the overall table size from changing, and then click the grip between 
the two columns.  

3. Move the SYMBOL column grip to the left to make the column narrower, and then click 
again to set the new width. Release CTRL.  

4. Press ESC to clear the selection on the table.  

5. Close your drawing without saving changes.  

Wrap Up 

You can use the Draw toolbar to create a table. You can add text or blocks to the table, add cells, 
and resize the table. You can also change the properties of the cell contents such as type style 
and alignment.
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Create a Sheet List Table 

You can use the Sheet Set Manager to create a table that lists all the sheets in the sheet set. 
When you remove, add, or renumber sheets, it is easy to update your sheet list table. You can 
also open a sheet directly from the sheet list table.  

Note: Before you begin the tutorial, if you have not already done so, copy the Tutorials folder from 
the Destination Desktop CD-Rom to My Documents. 

Open a Sheet Set and Open a Sheet 

You open a sheet set in the Sheet Set Manager.  

If you have not already done so, copy the Tutorials folder from CD-ROM to My Documents.  

 In AutoCAD, if the Sheet Set Manager is not already open, on the Standard toolbar, click 
Sheet Set Manager.  

In the Sheet Set Manager, click the arrow next to the Open box, and then click Open.  

In the Open Sheet Set dialog box, browse to the My Documents\Tutorials\sheetListTable folder, 
select Mechanical Unit.dst, and then click Open.  

The Mechanical Unit sheet set is displayed in the Sheet Set Manager. The Mechanical Unit sheet 
set contains five sheets.  

In the Sheet Set Manager, on the Sheet List tab, double-click the Title sheet.  

The Title sheet opens. This sheet is currently empty except for a title block. You want to insert a 
sheet list table on this sheet.  

Show Subheaders in the Sheet List Table 

When you insert a sheet list table, you can include subheaders (for subsets) in the table.  

1. In the Sheet Set Manager, on the Sheet List tab, right-click the Mechanical Unit sheet set, 
and on the shortcut menu, click Insert Sheet List Table.  
In the Insert Sheet List Table dialog box, under Table Style Settings, a preview of the 
sheet list table is displayed.  

2. Under the preview of the sheet list table, select Show Subheader.  
Notice that the preview of the sheet list table now displays subheaders.  
Do not close the Insert Sheet List Table dialog box.  
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Add Columns to the Sheet List Table 

In the Insert Sheet List Table dialog box, under Column Settings, two column headings (data 
types) are listed: Sheet Number and Sheet Title. You can add additional columns to the sheet list 
table. Here, you add another column.  

1. In the Insert Sheet List Table dialog box, under Column Settings, click Add.  

A third data type (by default, Sheet Number) is listed.  

2. Double-click the third data type (Sheet Number), and from the drop-down list, 
select Drawing Author.  

3. In the selected text box, enter Author.  

Do not close the Insert Sheet List Table dialog box.  

Modify Table Style Settings 

You can change the table settings, and control how information in the table is displayed.  

1. In the Insert Sheet List Table dialog box, under Table Style Settings, click the […] 
button to open the Table Style dialog box.  

Notice that Office Standard is the current table style. Table styles are defined in the sheet 
creation template. You can modify a table style.  

2. In the Table Style dialog box, click Modify.  

3. In the Modify Table Style dialog box, on the Column Heads tab, under Cell 
Properties, change the Alignment setting to Middle Left.  

The column heads are now justified to the left.  

4. On the Title tab, under Cell Properties, change the Alignment setting to Middle 
Left.  

The title head is now justified to the left.  

5. Click OK to close the Modify Table Style dialog box, and then click Close to close 
the Table Style dialog box.  

Do not close the Insert Sheet List Table dialog box.  
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Insert a Sheet List Table 

Next, you insert a sheet list table on your sheet.  

1. In the Insert Sheet List Table dialog box, click OK.  

The Sheet List Table message is displayed, notifying you that the sheet list table is 
automatically generated from the sheet list, and that any manual changes are temporary.  

You can manually edit individual cells in the sheet list table. However, because the sheet 
list table is automatically generated from the sheet list, all manual edits are lost whenever 
you update the sheet list table.  

2. Click OK.  

Notice that on the command line, you are asked to specify an insertion point for the sheet 
list table.  

3. Click anywhere on the sheet to place the sheet list table.  

Remove a Sheet and Update a Sheet List Table 

The sheet list table is automatically generated from the sheet list. When you add, remove, or 
renumber sheets, it is easy to update the sheet list table.  

1. In the Sheet Set Manager, on the Sheet List tab, right-click the Middle Roller 
sheet, and on the shortcut menu, click Remove Sheet.  

2. In the Remove Sheets dialog box, click OK.  

The sheet Middle Roller is no longer included on the Sheet List tab.  

3. Click any outside edge of the sheet list table to select it, right-click, and on the 
shortcut menu, click Update Sheet List Table.  

The Middle Roller sheet is no longer included in the sheet list table.  

Open a Sheet from the Sheet List Table 

From the sheet list table, you can open any sheet in the sheet set.  

1. In the sheet list table, place your cursor over the edge of the Top Plate sheet title 
until the globe icon is displayed.  

2. With the globe icon still displayed, hold down the CTRL key and click once.  

The Top Plate sheet opens in a new window.  

3. Close all drawings without saving changes.  

4. To close the Mechanical Unit sheet set, in the Sheet Set Manager, on the Sheet 
List tab, right-click Mechanical Unit, and on the shortcut menu, click Close Sheet Set.  

Wrap Up 

You use the Sheet Set Manager to automatically create a sheet list table. A sheet list table lists all 
the sheets in the sheet set. When you remove, add, or renumber your sheets, it is easy to update 
your sheet list table. 
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Manage Layers 

The Layer Properties Manager has been enhanced for greater usability. You can now access, 
organize, and manage your layers more efficiently. You can better control which layers you want 
to display, sort layers by name or by property, search for a group of layers, and delete and lock 
layers.  

Note: Before you begin the tutorial, if you have not already done so, copy the Tutorials folder 
from the Destination Desktop CD-Rom to My Documents. 

View the Layer Properties Manager 
1. If you have not already done so, copy the Tutorials folder from CD-Rom to My 
Documents.  

2. In AutoCAD, open My Documents/Tutorials/Office Plan.dwg.  

This drawing contains an office space plan with an attached external reference (xref).  

3. On the Layers toolbar, click Layer Properties Manager.  

The Layer Properties Manager is divided into two panes: the tree view on the left, and the 
list view on the right.  

The tree view displays all defined layer groups and filters. The list view displays all the 
layers in the current group or filter.  

4. In the tree view, make sure All is selected.  

When All is selected in the tree view, all layers in the drawing are displayed in the list view.  

5. In the tree view, click Xref.  

In the list view, only layers in the attached xref are displayed.  

Do not close the Layer Properties Manager.  
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Delete a Layer 

Next, you delete a layer from the list view.  

1. In the tree view, click All to display all layers in the drawing.  

In the list view, under Status, notice the green check mark next to the layer GRID-LINE. 
The green check mark indicates the current layer.  

In the FURNITURE layer, notice that the Status column displays a white layer icon (instead 
of blue). This indicates that the layer is empty. The Status column makes it easy to see 
which layer is current and which layers are empty.  

Near the bottom of the Layer Properties Manager, in the Layers status line, the total 
number of layers (27) is displayed.  

2. In the Layer Properties Manager, right-click Status, and then click Maximize All 
Columns.  

When all columns are maximized, longer layer names are displayed.  

3. Click the FURNITURE layer to select it, and then click the Delete Layer icon 
above the tree view. (Only layers that do not contain objects can be deleted.)  

Notice that a red X is now displayed on the FURNITURE layer icon to indicate it is marked 
for deletion.  

4. Click Apply to delete the FURNITURE layer.  

With Apply, you can make and view changes to layer states in your drawing without closing 
the Layer Properties Manager.  

The FURNITURE layer is deleted from the drawing and from the list view. Notice that the 
number of layers listed in the Layers status line has changed to 26.  

Do not close the Layer Properties Manager.  
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Search for Layers by Name 

You can use wild-card characters to search for and filter layers by name.  

1. In the Layer Properties Manager, click inside the Search for Layer text box 
(under the tree view).  

The cursor is displayed in the text box along with a trailing asterisk (*).  

2. In the text box, before the trailing asterisk, enter NOTE. (Make sure the text 
reads NOTE*.)  

By using the wild-card character * after NOTE, you search for all layers whose names 
begin with NOTE.  

The list view changes to display only those layers whose names begin with NOTE. The 
number of layers displayed (2) and the total number of layers (26) are shown in the Layers 
status line.  

3. In the list view, right-click NOTE-EMPLOYEE, and then on the shortcut menu, 
click Select All.  

All layers in the list view (NOTE-EMPLOYEE and NOTE-ROOM) are selected. You can 
lock these layers with a single click.  

4. In the list view, click the Lock icon next to either of the layers.  

Both layers are now locked.  

5. Click Apply to apply the layer changes to the drawing without closing the Layer 
Properties Manager.  

Do not close the Layer Properties Manager.  
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Create a New Layer Properties Filter 

You use a layer properties filter to define a filter that controls which layers are displayed in the list 
view. You can also use a layer properties filter to make changes to more than one layer at a time.  

1. In the Layer Properties Manager, in the text box under the tree view, delete the 
text NOTE*.  

2. In the tree view, click All.  

All the layers are now displayed in the list view.  

3. Click the New Property Filter button (in the upper-left corner of the Layer 
Properties Manager).  

4. In the Layer Filter Properties dialog box, under Filter Name, enter AllGrid.  

5. Under Filter Definition, select the Name field, and then enter *GRID*.  

Using the wildcard character * before and after GRID filters all layer names containing the 
word GRID.  

Two layers, GRID-BUBBLE and GRID-LINE, are displayed under Filter Preview.  

6. Click OK to close the Layer Filter Properties dialog box.  

In the Layer Properties Manager, in the tree view, the layer filter you created (AllGrid) is 
selected.  

In the list view, only the GRID layers are displayed.  

Next, you want to freeze all the layers except GRID layers. You can do this by isolating 
layers.  

7. In the tree view, click AllGrid. Right-click, and on the shortcut menu, click Isolate 
Group > All Viewports. Then, click Apply.  

Notice that in your drawing, all the layers except the GRID layers are frozen. Using Apply 
lets you view changes to layer states in your drawing without closing the Layer Properties 
Manager.  

Next, you thaw all layers.  

8. In the tree view, click All to display all the layers in the drawing.  

9. With All still selected, right-click, and on the shortcut menu, click Visibility > 
Thawed.  

In the list view, all the layers are displayed as thawed.  

10. Click Apply to thaw the layers in the drawing.  

Do not close the Layer Properties Manager.  
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Create a New Group Filter 

In addition to filtering layers by property, you can create layer group filters, and manually arrange 
layers into groups. Once you create a layer group filter, the new layer group filter is added to the 
tree view. You can then drag layers from the list view into the new layer group filter.  

1. In the Layer Properties Manager, click the New Group Filter button (the middle 
button in the upper-left corner of the Layer Properties Manager).  

A new, empty group filter (Group Filter1) is created and displayed in the tree view.  

2. In the highlighted text box, enter FURNITURE to name the new group filter, and 
then press ENTER.  

3. In the tree view, click All to display all the layers in the drawing.  

4. In the list view, hold down the CTRL key and select the following layers:  

o CHAIRS  

o CPU  

o DESKS  

o FILE-CABINETS  

o PHONES  

5. Drag the selected layers into the FURNITURE group filter in the tree view.  

6. In the tree view, click the FURNITURE group filter icon.  

The layers you selected (CHAIRS, CPU, DESKS, FILE-CABINETS, and PHONES) are 
now included in the FURNITURE group filter. In the list view, only these layers are 
displayed.  

Do not close the Layer Properties Manager.  
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Save a Layer State 

You can save multiple sets of layer states in your drawing. Here, you turn off the layers in the 
FURNITURE layer group filter, and then you save the layer state.  

1. In the Layer Properties Manager, in the tree view, select the FURNITURE group 
filter, right-click, and on the shortcut menu, click Visibility > Off.  

In the list view, all layers in the FURNITURE group filter are now turned off.  

2. Click Apply to turn off the FURNITURE group filter layers in your drawing.  

Next, you save the current layer state.  

3. In the Layer Properties Manager, click the Layer States Manager button (the third 
button in the upper-left corner of the Layer Properties Manager).  

4. In the Layer States Manager, click New.  

5. In the New Layer State to Save dialog box, under New Layer State Name, enter 
NOFURNITURE, and then click OK.  

6. In the Layer States Manager, under Layer Settings to Restore, click Select All to 
select all of the settings.  

When you create a new layer state, only the settings that are selected are saved (and 
restored) with the layer state.  

7. In the Layer States Manager, click Close to return to the Layer Properties 
Manager.  

Do not close the Layer Properties Manager.  
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Restore a Layer State 

Once you save a layer state, you can easily restore the saved layer state. Saving and then 
restoring layer settings is convenient if you need to return to particular layer settings during the 
different stages of a drawing.  

1. In the Layer Properties Manager, in the list view, right-click the PHONES layer, 
and on the shortcut menu, click Select All.  

2. In the list view, click the On icon next to any of the layers, and then click Apply.  

All the layers in the FURNITURE layer group are turned on.  

3. In the tree view, click All to display all the layers in the list view.  

Next, you want to restore the NOFURNITURE layer state.  

4. In the Layer Properties Manager, click Layer States Manager.  

In the Layer States Manager, the NOFURNITURE layer state is listed.  

5. To restore the NOFURNITURE layer state, click Restore.  

In the Layer Properties Manager, in the list view, the layers in the FURNITURE group 
(CHAIRS, CPU, DESKS, FILE-CABINETS, and PHONES) are turned off.  

6. Click Apply to turn off the layers in the drawing.  

In the drawing, the NOFURNITURE layer state has been restored to its saved state (the 
furniture layers are off).  

7. Click OK to close the Layer Properties Manager, and then close your drawing 
without saving changes. 

 

Wrap Up 

You use the Layer Properties Manager to help manage large groups of layers. To better control 
which layers you want to display, you can create filters and sort the layers by name or by 
property. You can also manually organize layers into groups, and control the visibility of the whole 
layer group.  

You can save the current layer settings in a drawing, and then restore them later. Saving layer 
settings is convenient if you need to return to particular layer settings during the different stages 
of a drawing.  

   

 

 

 

 
 
 


